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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed 
as constituting an additional warranty. HP shall not be liable for technical or editorial errors 
or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or 
copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 
Computer Software Documentation, and Technical Data for Commercial Items are licensed 
to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 1992 - 2010 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

JavaTM is a US trademark of Sun Microsystems, Inc.

Microsoft® and Windows® are U.S registered trademarks of Microsoft Corporation.
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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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What’s New

The What’s New includes:

➤ "What’s New in HP ALM" on page 9

➤ "What’s New in HP ALM Performance Center" on page 33
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What’s New in HP ALM

This What’s New guide provides an overview of the features that were 
introduced or enhanced in HP Application Lifecycle Management (ALM) 
11.00. For more information on using HP ALM, refer to the HP Application 
Lifecycle Management User Guide.

You can also view video demonstrations of HP Application Lifecycle 
Management features by choosing an item from Help > Product Feature 
Movies. 

What’s New in HP ALM includes the following topics:

➤ HP Application Lifecycle Management 11.00 on page 10

➤ Installation on page 12

➤ Optimized Project Repositories on page 13

➤ Side-by-Side ALM Clients on page 13

➤ Project Planning and Tracking (PPT) Releases on page 14

➤ Business Process Model Integration on page 14

➤ Traceability Matrix on page 15

➤ Test Configurations on page 15

➤ New Manual Runner - HP Sprinter on page 15

➤ Project Reports on page 16

➤ User Updates on page 17

➤ Administration Updates on page 21

➤ Changes in Feature Availability on page 25

➤ API and Database Updates on page 26
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➤ Business Process Testing on page 28

➤ Documentation Library on page 31

HP Application Lifecycle Management 11.00

HP Application Lifecycle Management (ALM) empowers IT to manage the 
core application lifecycle, from requirements through deployment, granting 
application teams the crucial visibility and collaboration needed for 
predictable, repeatable, and adaptable delivery of modern applications.

ALM supports you through all phases of the application lifecycle 
management. By integrating the tasks involved in application management, 
it enables you to better align IT with your business needs. For more 
information, refer to the HP Application Lifecycle Management User Guide.

ALM also includes Performance Center functionality, enabling you to 
manage all aspects of a large-scale performance testing project, including 
resource allocation and scheduling, from a centralized location accessible 
through the Web. For details on new features in Performance Center, see 
"What’s New in HP ALM Performance Center" on page 33.

The ALM solution also includes Application Governance functionality. This 
component is primarily a design-time governance platform for service 
infrastructure. For more information, refer to the HP ALM Application 
Governance documentation.
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HP ALM Editions

HP Application Lifecycle Management (ALM) is also available in three 
editions which provide subsets of ALM functionality — HP Quality Center 
Starter Edition, HP Quality Center Enterprise Edition, and HP ALM 
Performance Center Edition.

For more information, refer to the HP Application Lifecycle Management User 
Guide.

HP ALM Edition Description

HP ALM Complete HP ALM functionality, providing core 
functionality for managing the Application Lifecycle 
and scalable Quality Management for mature 
organizations and Centers of Excellence (CoE) 
involved with managing enterprise releases. 

HP Quality Center 
Starter Edition

For quality management teams managing small 
releases.

HP Quality Center 
Enterprise Edition

For quality management teams managing medium to 
large releases.

HP ALM Performance 
Center Edition

For managing all aspects of large-scale performance 
testing projects.
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Installation

The following updates have been made to the installation process. For more 
information, refer to the HP Application Lifecycle Management Installation 
Guide.

Supported Environments
For the supported and recommended system configurations for your ALM 
server and client machine, refer to the HP Application Lifecycle Management 
11.00 Readme. 

Important: The supported environment information in the HP Application 
Lifecycle Management 11.00 Readme is accurate for the ALM 11.00 release, but 
there may be updates for ALM 11.00 patches. For the most up-to-date 
supported environments, refer to the HP Software Web site using the 
following URL: http://www.hp.com/go/TDQC_SysReq

ALM offers integrations with other HP testing tools. To verify that you are 
using a supported version, on the Add-ins page, click the More 
HP Application Lifecycle Management Add-ins link. Choose the ALM 11.00 
integration matrix.

Installation Wizard

➤ Validations have been added throughout the installation process.

➤ The installation wizard now consists of two stages: file delivery and server 
configuration. This means that you can reconfigure the server without 
having to reinstall the application.

http://www.hp.com/go/TDQC_SysReq
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Data Security
ALM encrypts information for accessing external systems (databases, 
Windows, and LDAP), and secures communication with other HP BTO 
applications.

ALM Client
Installing an ALM client no longer requires administrator privileges on the 
machine. Administrator privileges are still required for installing certain 
add-ins.

Optimized Project Repositories

Project files are now saved over an optimized repository system, that ensures 
better performance for common actions, and extends the capacity of the file 
system.

Files in the project repository are stored in an optimized folder structure that 
allows maximum storage space. In addition, any two files with identical 
content are stored in the repository only once. This results in a significant 
reduction in disk space. For example, if you attach the same file to several 
ALM records, the file is stored only once in the project repository.

For more information, refer to the HP Application Lifecycle Management 
Administrator Guide.

When upgrading from Quality Center 9.2 or 10.00, ALM migrates files from 
the legacy project repository to the optimized project repository. 

Side-by-Side ALM Clients

You can now run multiple versions of HP Application Lifecycle Management 
(ALM) side-by-side on a workstation. This includes multiple ALM 11.00 
clients connecting to different ALM Platform servers, and a single 
Quality Center 10.00 or 9.2 client.

For more information, refer to the HP Application Lifecycle Management 
Installation Guide.



What’s New

14

14

Project Planning and Tracking (PPT) Releases

Using the Project Planning and Tracking (PPT) feature, you can now track 
application readiness by defining milestones for activities of an application 
release in the Releases module. PPT uses key performance indicators (KPIs) 
to analyze the data of your defined milestones. The overall health and 
deployment readiness of a release in displayed in the form of a scorecard. 
The scorecard monitors and tracks how well each milestone is being met on 
a daily basis. To further analyze your output, you can generate dashboard 
reports and graphs.

For more information, refer to the HP Application Lifecycle Management User 
Guide.

PPT is not available for HP Quality Center Starter Edition, HP Quality Center 
Enterprise Edition, or HP ALM Performance Center Edition.

Business Process Model Integration

You can now import business process models created in external model 
authoring tools. Importing business process models into the new Business 
Models module automatically creates a framework of requirements 
representing each model and activity. You can then create test coverage and 
assess the quality of your business process models.

In addition, you can add path entities to your models that represent end-to-
end sequences of activities, enabling you to test your business flows.

For more information, refer to the HP Application Lifecycle Management User 
Guide, and to the HP ALM Business Models Module Best Practices Guide.

The Business Models module is not available for HP Quality Center Starter Edition 
or HP ALM Performance Center Edition.
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Traceability Matrix

You can now determine the extent of relationships between requirements 
and other requirements, and between requirements and tests using the 
Traceability Matrix view in the Requirements module. The traceability 
matrix helps you verify that all requirements are met, and identify changes 
to the scope of your requirements when they occur. For more information, 
refer to the HP Application Lifecycle Management User Guide.

Test Configurations

Using the Test Configurations tab in the Test Plan module, you can now 
design tests that run according to different use-cases, each with different sets 
of data. Each use-case is called a test configuration. Values for the test 
configurations are supplied from within your ALM project or from an 
external data resource. For more information, refer to the HP Application 
Lifecycle Management User Guide.

New Manual Runner - HP Sprinter

You can now run manual tests in ALM from the Test Lab module using the 
new HP Sprinter. Sprinter provides enhanced functionality and a variety of 
tools to assist in the manual testing process, including: 

➤ the ability to create and annotate screen captures

➤ capture movies of your run

➤ record and run macros on your test application

➤ automatically enter data into fields in your application

➤ automatically include the list of your steps or user actions in any defect 
you submit

➤ replicate your user actions on multiple machines with different 
configurations
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For more information, refer to the HP Sprinter User Guide, available from the 
HP Application Lifecycle Management Adds-ins Page (select Help > Add-ins 
Page).

Sprinter functionality is not available with HP Quality Center Starter Edition or 
HP ALM Performance Center Edition.

Project Reports

A new Project Report reporting tool is available in the Analysis View 
module, enabling you to design and generate comprehensive reports of 
project data. Using templates designed by the project administrator for each 
ALM entity, users create project reports, by selecting the entities that are 
included in report sections, and defining data filters.

Project reports offer the following advantages:

➤ Rich style and layout option using MS Word templates.

➤ Enhanced performance.

➤ Single configuration for multiple output formats (doc, docx, html).

➤ Centralized template management.

For more information, refer to the HP Application Lifecycle Management User 
Guide.
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User Updates

This section describes usability enhancements in HP Application Lifecycle 
Management 11.00. For more information, refer to the HP Application 
Lifecycle Management User Guide.

Module Navigation
A new module navigation sidebar enables quick access to the modules 
available in ALM.  

Favorite Views
You can now add subfolders to help you organize your favorite views. For 
example, you can create folders to organize favorite views by product, 
release version, or team. 

Library Enhancements
The following enhancements were made in the Libraries module:

➤ The library creation process has been improved. It includes the following 
enhancements:

➤ Filtered libraries. Previously, when you created a library, all records 
within the folders you selected were added to the library. In 
ALM 11.00, when you create a library, you can also define a filter for 
each entity tree you include, providing you with better control over 
library content.

➤ Automatically include related entities during baseline creation. 
Previously, when you created a library that included tests, you also 
needed to select all the related entities that were required for the tests 
to run, such as called tests and test resources. In ALM 11.00, these 
related entities are automatically included when you create a baseline 
for the library.

➤ Add tests to a library based on coverage. When you select tests to 
include in a library, you now have the option to automatically include 
only those tests that cover requirements in the library.
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➤ Export baseline and library comparison results. You can now save 
baseline and library comparison results in .csv file format. 

The Libraries module functionality is not available for HP Quality Center Starter 
Edition.

Requirements Enhancements
The following enhancements were made in the Requirements module:

➤ Requirements Ordering. Previously, requirements were added to the 
requirements tree by order of creation. To arrange the order, you sorted 
the tree by selected fields. In ALM 11.00, you can move the requirements 
in any logical order in the tree. 

➤ Rich Text Editor. The rich text feature has been improved in ALM 11.00. It 
includes the following enhancements:

➤ changed from a Microsoft Word-based editor to an HTML editor 

➤ expanded the viewable area

➤ improved performance of opening and saving rich text

➤ available as searchable field

➤ enables using a rich text template

Test Execution Enhancements
The following enhancements were made in the Test Lab module:

➤ The Test Lab module now contains two main tabs:

➤ The Test Sets tab displays the test sets tree view.

➤ The Test Runs tab displays all project runs in a grid.

The Test Sets Grid View is no longer available.

➤ Run management. You can now view and filter all runs for your project in 
a single grid view. This is available from the new Test Runs tab in the Test 
Lab module. 
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➤ Draft runs. You can now set a test as a draft run to instruct ALM to ignore 
the run results. This enables you to try out tests while they are still in 
development or after they have been modified without impacting 
statistics such as test or coverage status. 

➤ Run State field. The new test run State field enables you to track the 
status of a run in progress. 

➤ Blocked run status. A new status has been added to test runs. The Blocked 
status indicates that the test cannot run. This enables you to distinguish 
between tests that were not completed, possibly due to lack of time, and 
those that could not be completed for some other reason, such as network 
problems or hardware failure. 

➤ Execution summary. You can now instruct ALM to send a summary of test 
results in an email to specified users when test set execution completes. 
This option is available from the Automation tab. 

➤ The Test Instance Properties dialog box is renamed the Test Instance 
Details dialog box.

Dashboard Enhancements
The following enhancements were made in the Dashboard module:

➤ The Dashboard module now contains two sub-modules:

➤ The Analysis View module contains the analysis items that were 
previously displayed in the Analysis View tab.

➤ The Dashboard View module contains the dashboard pages that were 
previously displayed in the Dashboard View tab.

➤ Graphs. The following enhancements are introduced in graphs:

➤ Sharing Graphs. You can now share graphs for viewing in a Web 
browser, without downloading an ALM client. 

➤ Configuration Options. In progress and trend graphs, you now have 
full control over the time period that is covered by graphs.  
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Task Manager
You can now view the progress and status of asynchronous tasks run in your 
project. The new Task Manager dialog box enables you to view tasks that run 
in the background, such as creating a baseline or importing a library. 

Session Reconnect
When your ALM session is inactive for a period of time, the session expires. 
Previously, this required you to log out and log in again, which includes 
reloading project customization.

Now, when your session expires, you are prompted to reconnect. If the 
project administrator has not made any significant changes to the project 
customization, the customization does not reload, enabling you to 
reconnect quickly and continue working where you left off.
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Administration Updates

This section describes administration enhancements in HP Application 
Lifecycle Management 11.00. For more information, refer to the 
HP Application Lifecycle Management Administrator Guide.

Importing LDAP Users
Previously, you could import LDAP users by browsing and filtering the LDAP 
tree. In ALM 11.00, you can search LDAP users by entering keywords. 

Enabling Project Extensions
You can now enable extensions for a project while creating the project. 
Previously, you could enable an extension for a project only after creating 
the project. 

Cross Project Customization
When you apply template customization, module access customization in 
the template is now applied to linked projects. 

Cross Project Customization is not available for HP Quality Center Starter Edition 
or HP Quality Center Enterprise Edition.
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Deactivating Users
You can now deactivate users in Site Administration. An inactive user 
cannot log in to any ALM project. This enables you to temporarily deny a 
user access to projects, while maintaining user details, and preserving a 
user’s settings and permissions. 

Update Test Types
After registering custom test types with ALM, you are now required to 
synchronize changes with active projects in Site Administration. 

QC Sense
You can now analyze ALM usage and performance data using QC Sense, the 
new internal monitoring tool. QC Sense collects data on user actions 
performed in the ALM user interface, and monitors all client and server 
activity resulting from those actions. You can generate reports based on 
QC Sense data, enabling you to examine and compare performance. 

Site Configuration
In the Site Configuration tab, the following parameters were added:

➤ DEBUG_CLOSURE_LOG_DOM_PROJ

➤ DISABLE_PASSWORD_OTA_ENCRYPTION

➤ ENTITY_LINK_HOST

➤ ENTITY_LINK_PORT

➤ EVENT_LOG_PURGE_PERIOD_DAYS

➤ EXTENDED_MEMO_FIELDS

➤ FAST_RECONNECT_MODE

➤ LIBRARY FUSE

➤ REQUIREMENTS LIBRARY FUSE

➤ REST_API_DEFAULT_PAGE_SIZE

➤ REST_API_MAX_PAGE_SIZE
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➤ REST_SESSION_MAX_IDLE_TIME

➤ SSO_EXPIRATION_TIME

➤ SUPPORT_TESTSET_END

The following parameters were removed:

➤ ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE

➤ LIBRARY_BROKEN_LINKS_VERIFICATION_FUSE

Workflow Events
Workflow event procedures were added for the following modules.

Module Events

Releases ➤ ReleaseFolder_AfterPost

Business Models ➤ CanReImportModels

➤ A set of events (such as _MoveTo, _FieldChange) 
for the BusinessModel, BusinessModel_Activity, 
BusinessModelPath, and BusinessModelFolder 
entities.

Business Components ➤ CanAddComponentstoTest

➤ CanRemoveComponentsFromTest

➤ CanAddFlowsToTest

➤ CanRemoveFlowsFromTest

➤ CanDeleteGroupsFromTest

➤ Component_CanDelete and 
ComponentFolder_CanDelete. (Separate 
CanDelete event syntaxes are now available for 
components and component folders.)

➤ A set of events (such as _New, _FieldChange) for 
the ComponentFolder entity.
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Other enhancements include: 

➤ The GetDetailsPageName event is now supported for all entities, not just 
defect entities.

➤ Certain events are no longer supported for new projects, but for purposes 
of backward compatibility, are available in upgraded projects (for 
example, MoveToSubject and GetNewReqPageName). 

For more information, refer to the HP Application Lifecycle Management 
Administrator Guide.

Test Plan ➤ Test_CanDelete and TestFolder_CanDelete. 
(Separate CanDelete event syntaxes are now 
available for tests and test folders.) 

➤ A set of events (such as _New, _FieldChange) for 
the TestFolder and TestConfiguration entities.

Test Lab ➤ RunTests_Sprinter

➤ TestSet_CanDelete and TestSetFolder_CanDelete. 
(Separate CanDelete event syntaxes are now 
available for test sets and test set folders.) 

➤ A set of events (such as _New, _FieldChange) for 
the TestSetFolder entity.

Module Events
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Changes in Feature Availability

The following features are no longer supported in HP Application Lifecycle 
Management 11.00:

WinRunner EOL

You can no longer create WinRunner tests in ALM 11.00. However, if you 
are upgrading from a previous version of Quality Center, you can still run 
your existing WinRunner tests. 

Defect Customization: Visible Fields in Add Defect Dialog Box

The Visible Fields in Add Defect Dialog Box field in Groups customization is 
no longer available in ALM 11.00. To determine which Defect fields are 
visible, use the Select Fields dialog box from the Data-hiding tab of the 
Groups and Permissions page in the Customization module. Alternatively, 
you can create a workflow script. 

Printing Defects

In the Defects module, you can no longer print defects directly from the 
Defects Grid. Instead, you can export defect data, or generate graphs and 
reports of defect data.

Library Broken Links Verification

The verification of broken links is no longer a part of the baseline creation 
process in ALM 11.00. The baseline creation process now automatically 
includes all the related entities that tests in the library need in order to run. 
For more information, see "Library Enhancements" on page 17.

Fixed Columns in the Defects Grid.

The option of setting non-scrolling columns displayed in the Defects grid is 
no longer available.
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Add Required Fields to Grid

When adding a test to a test set, or creating or updating a defect, the option 
to automatically add required fields to the grid is no longer available. 
Instead, you can use the Select Columns option to add the required fields.

Assigning Existing Sets of Permissions to User Groups

When you create a new user group, you can assign the privileges of an 
existing user group that has similar access privileges to those you want to 
assign to the new group. The option of later resetting one user group's 
permissions according to another group's permissions is no longer available. 

Adding Users to Projects from a Previous Version

In ALM 11.00, you cannot add users to a project from an earlier version 
before you upgrade the project.

API and Database Updates

This section describes API updates: 

➤ ALM 11.00 can use Client-Side Deployment so that a client can connect 
to more than one ALM Platform. This affects APIs in the following ways:

➤ The OTA type library is no longer registered automatically on the 
client machine. Before connecting to an ALM Platform with an OTA 
application, register the library for the server by running HP ALM 
Client Registration from the ALM Add-ins page. For more 
information, see Registering ALM on a Workstation in the HP ALM 
Installation Guide.

➤ The installation of custom test types has changed. See the HP ALM 
Custom Test Type Guide.

➤ There are now ALM REST resources available. For details, see the HP ALM 
REST API Reference.

➤ The content of the HP Quality Center Entity Dependencies API Reference that 
was published with Quality Center has been merged into the HP ALM 
Open Test Architecture Reference. The dependencies reference is not 
delivered as a separate help with ALM.
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➤ The following properties of the OTA CustomizationPermissions object are 
now read-only:

➤ CanAdditem

➤ CanAllowAttachment

➤ CanModifyField

➤ CanModifyItem

➤ CanRemoveItem

➤ CanUseOwnerSensible

➤ The following methods of the OTA CustomizationAction object are 
obsolete:

➤ AddGroup

➤ RemoveGroup

➤ The OTA TreeMananager object is now responsible only for the Test 
Subject tree. For project lists, use Customization.Lists.

➤ Rich text fields are now saved as memo fields and not as .DOC files.

➤ The Site Administration API’s CreateProjectCopy method no longer 
supports the SA_PROJECT_CREATION_FORCE_IF_ACTIVE option. A 
project must be deactivated before it can be copied.

➤ The HISTORY table no longer exists. Events are now logged in the 
AUDIT_LOG and AUDIT_PROPERTIES tables. There are corresponding 
changes to OTA.

➤ New items in the API and database references are marked with a red tag in 
the table of contents. The tag is at the object or table level. Individual 
fields, methods, and properties are not tagged.
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Business Process Testing 

New HP Application Lifecycle Management 11.00 features are also 
supported for Business Process Testing entities. In addition, the 
Business Process Testing features described below have been introduced or 
enhanced in ALM 11.00. 

For more information on these features, refer to the 
HP Business Process Testing User Guide.

Improved Performance when Running QuickTest 
Automated Components
To improve performance, business process tests or flows that contain only 
QuickTest automated components now compile as QuickTest tests using a 
mechanism called BPT wrapper tests. The tests and flows are automatically 
wrapped when QC executes the test without any action on the user’s part. 
For more information on running tests with the BPT wrapper test 
mechanism, refer to the HP Business Process Testing User Guide. 

Availability
Business Process Testing is now available with both the Quality Center 
Starter Edition and the Quality Center Enterprise Edition. For more 
information, refer to the HP Application Lifecycle Management User Guide. 

Enhanced User Interface
The following enhancements were made to the Business Process Testing user 
interface:

➤ The “look and feel” for business process tests and flows in the Test Plan is 
redesigned. For example, the flat list of components is now replaced by a 
tree-like view, enabling you to collapse and expand groups of components 
in the tree.

➤ The Iterations dialog box now provides additional capabilities such as 
searching for values, toggling between single and multiple iteration views, 
and more.
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Application Area Improvements
Application areas are now standard test resources and are available from the 
ALM Test Resources module. As a result, you can easily recognize the 
components linked to each application area and each application area’s 
content (such as object repositories and function libraries). 

Improvements include: 

➤ Application areas can now be created in the ALM Test Resources module, 
without having to open the QuickTest Professional testing tool. For more 
information, refer to the HP Business Process Testing User Guide.

➤ Component dependencies on application areas can now be viewed.

➤ Application areas are included in libraries and baselines, and can be 
compared and imported.

➤ Application areas (excluding the BusinessComponentTemplate10 
template application area) that are not associated with a component can 
be deleted from within ALM without having to open the QuickTest 
Professional testing tool. 

Test Configurations that Access Static and Dynamic Data
Business Process Testing supports test configurations that access static data 
and test configurations that access dynamic data. 

➤ While ALM test configurations access static data at a configuration level, 
business process test configurations enable you set different data values at 
for each iteration. 

➤ You can create test configurations for business process tests that access 
dynamic data. Dynamic data enable you to run test instances using test 
configurations based on an external data resource file, such as Microsoft 
Excel. 

The granularity of requirement coverage is expanded, because a requirement 
can be covered by a business process test and several of its test 
configurations (use cases), each test configuration testing different data on 
the same test script.

For more information, refer to the HP Business Process Testing User Guide.
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Criteria
When creating coverage between requirements and business process tests, 
instead of covering each requirement only at the level of a test, you can 
define coverage by a test criterion such as a business component and/or a 
flow. 

This feature expands the granularity of requirement coverage, allowing 
more accurate results to be propagated to the ALM Requirements module. 
You can select which components and flows interest you from the coverage 
perspective, and only those components and flows affect requirement 
coverage calculations.

For more details on test criteria, see the HP Business Process Testing User 
Guide. 

Additional Features in the New Manual Runner - 
HP Sprinter
In addition to the features listed above under "New Manual Runner - 
HP Sprinter" on page 15, the following enhanced functionality is available 
for Business Process Testing: 

➤ the ability to view parameters in your steps

➤ flows can be expanded and collapsed as any other entity in the test 
hierarchy

➤ the ability to navigate to the previous/next components in the Steps 
sidebar

For more information, refer to the HP ALM Sprinter User Guide, available 
from the HP Application Lifecycle Management Adds-ins Page (select Help > 
Add-ins Page).

Changes in Feature Availability

➤ The grid view for the Business Components module was removed.

➤ Parameter types were removed. All parameters are now of type string.
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Documentation Library

The following updates were made to the HP ALM Documentation Library.

New Look
For some user related functionality, the documentation content has been 
reorganized to enable quicker access, with feature descriptions divided into 
topics:

➤ Use concept topics for background, descriptive, or conceptual 
information about what a feature does.

➤ Use task topics for step-by-step guidance to help you work with the 
application and accomplish your goals.

➤ Use reference topics to look up specific reference information relevant to 
a particular feature. This includes understanding user interface elements, 
such as a window, dialog box, or wizard.

New Documentation
The following additions have been made to the documentation:

➤ The HP ALM Documentation Library now includes Performance Center 
documentation. Note that the previous HP Performance Center Monitor 
Reference is now incorporated into the new HP ALM Performance Center 
Guide. This guide now includes both user and administration 
documentation.

➤ Best Practices Documentation includes two new guides: 

➤ The HP ALM Upgrade Best Practices Guide provides methodologies for 
preparing and planning your ALM upgrade.

➤ The HP ALM Business Models Module Best Practices Guide provides best 
practices for working with the new Business Models module. 

➤ API References now includes a new online HP ALM REST API Reference. 
You can use the REST API to access and work with ALM data.
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Discontinued Documentation

The following deliverables have been discontinued:

➤ HP Quality Center Upgrade Preparation Guide: The content of this guide is 
now available as part of the HP ALM Administrator Guide in "Upgrade 
Preparation Troubleshooting".

➤ HP Quality Center Entity Dependencies API Reference: The content from this 
help file is now available as part of the HP ALM Open Test Architecture 
Reference.

➤ HP Business Process Testing Tutorial: Refer instead to the Product Feature 
Movies for Business Process Testing.
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What’s New in HP ALM 
Performance Center

This chapter provides an overview of the features that were introduced or 
enhanced in HP ALM Performance Center 11.00. For more information on 
using HP ALM Performance Center, refer to the HP ALM Performance Center 
Guide.

You can also view video demonstrations of HP ALM Performance Center 
features by choosing an item from Help > Product Feature Movies. 

What’s New in HP ALM Performance Center includes the following 
topics:

➤ Administration and Lab Management on page 34

➤ User Features on page 36

➤ Standalone Applications on page 41

➤ Feature Mapping on page 43
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Administration and Lab Management

The following administration enhancements have been added:

Enhanced Project Management
Projects are now created and managed on the ALM Platform. The main 
benefits are:

➤ The ability to group projects into domains based on various criteria. For 
example, Line of Business, Application.

➤ Flexible project customization that includes adding fields and properties 
to existing entities.

➤ Project templates enabling you to define and maintain a common set of 
project customizations for multiple projects.

➤ Import and export capabilities enabling easy archiving of projects.

Virtual User Days (VUDs)
ALM Performance Center 11.00 provides a new pay-per-use licensing model 
that helps service providers and enables sporadic testing. VUDs are licensed 
on a daily basis and can be used for any protocol. 

Once a license for a VUD is activated, it can be used for 24 hours for 
multiple performance tests and for any protocol. After 24 hours the VUD 
expires and is deducted from the license. 

VUDs can be used as a more flexible licensing model or when a temporary 
license for additional Vusers is needed. VUDs can also be used when you do 
not have a permanent license for a particular protocol.
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Improved Host Management
There is now more flexibility in the way hosts are assigned to projects and 
used in performance tests (previously known as load tests). 

Merged pools have been removed and, instead, any host can be assigned to 
multiple pools. This enhancement facilitates host sharing among projects. 
In addition, hosts can be linked to a host pool directly from the pool itself. 

Another important enhancement is the Host Properties feature. Using 
Project Customization, the list of available properties (for example, location, 
CPU Power, Memory Size, Software Installations, and so on) can be defined 
and can be selected for each host. These properties can be used when 
designing performance tests and reserving timeslots to narrow down the 
automatch hosts (previously known as virtual hosts) and find an 
appropriate match.

Enhanced System Health Checks
The new Check Host and Check Server features enable tracking and 
maintaining the system's status. These periodic checks are run automatically 
and ensure constant monitoring of the system’s key components. In 
addition, several automated tasks have been added to locate and fix any 
failures that may occur.

Full Redundancy 
ALM Performance Center is based on the ALM Platform which supports 
multiple nodes. Multiple Performance Center Servers with internal load 
balancing mechanisms can also be added. 
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User Features

The following user enhancements have been added:

Requirements to Defects Traceability
You can now manage performance requirements, and trace their status 
down to defects. A defect can be linked directly to a requirement, or to the 
performance test that covers it.

The following workflow is recommended:

 1 Define a performance requirement.

 2 Cover the requirement by a performance test.

 3 Define the appropriate service level agreement.

 4 Link relevant defects to the test runs.

(Note that the use of requirements and defects within Performance Center 
may require additional licenses.)

Timeslot Reservations
The timeslot reservation user interface is now more informative and 
intuitive and includes the following improvements:

➤ The calendar view includes the following enhancements:

➤ Displays multiple reservations in parallel.

➤ The ability to view complete details of timeslot reservations, including 
the allocated hosts, from your project and any other project accessible 
to you.

➤ Displays dual time zones.

➤ The ability to select a daily or weekly view.

➤ Displays a quick view of upcoming reservations.
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➤ Reserving new timeslots includes the following enhancements:

➤ The ability to define a name for the timeslot.

➤ The scheduling assistant provides a clear indication of when requested 
resources are available.

➤ Reserves a mixture of specific and automatch hosts (previously known 
as actual and virtual hosts respectively) in the same timeslot.

➤ Automatch hosts can be refined using host properties that provide 
more specific characteristics about the hosts that are needed.

➤ There is a new type of timeslot: a maintenance timeslot. This is 
scheduled by the Performance Center administrator in 
Lab Management and is used to allocate hosts for maintenance tasks 
such as patch installations.

➤ Error handling includes the following enhancements:

➤ Comprehensive and detailed information in case of allocation 
problems.

➤ Timeslot failure generates email notifications.

➤ Changes to a performance test are automatically propagated to a 
timeslot linked to the performance test.

➤ A grid view is available with more advanced filtering and sorting 
capabilities.

Application Under Test (AUT) Management
This feature introduces the capability to manage an inventory of application 
under test (AUT) hosts. The AUT hosts can be grouped into AUT host pools, 
similar to Performance Center hosts and host pools.

The AUT hosts are a core element of the new Topology and SiteScope 
integration features. As such, they can be added not only in Lab 
Management, but also in the ALM project itself.
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Topology and SiteScope Integration
ALM Performance Center can now articulate the Application Under Test 
topology (deployment view) and use it as an interface for defining 
performance monitors using the new integration with HP SiteScope. 

Key added value introduced:

➤ All stakeholders in the project can visually understand the tested 
environments.

➤ Monitor template deployment facilitates monitor configuration.

➤ Runtime performance issues are pinpointed by highlighting a topology 
node's status based on the SiteScope monitor threshold.

➤ New and improved SiteScope integration:

➤ SiteScope user interface is hosted in ALM Performance Center, 
enabling leveraging SiteScope functionality in a use-case oriented 
approach, without requiring additional monitor configuration on the 
Performance Center side.

➤ Ability to control whether or not to run monitors outside the context 
of the performance test. This contributes to the scalability of the 
SiteScope server, and reduces network noise when no tests are running.

➤ SiteScope data is displayed in different graphs in the 
Performance Center run screen and measurement names can be easily 
identified and filtered.
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Enhanced Performance Test Assets Management
Management of performance testing assets (tests, scripts, and monitors) has 
been improved and includes the following enhancements:

➤ Manages your assets in a hierarchal folder tree view.

➤ Manages test execution cycles.

➤ Copies all testing assets within and between projects.

➤ Uses version control to track changes.

➤ Manages assets in libraries that are shareable between projects.

➤ You can now benefit from advanced management of dependencies 
between testing assets, for example, performance tests and scripts.

Performance Test Design Enhancements
ALM Performance Center has improved the usability and capabilities 
provided in the performance test design phase. The following capabilities 
have been added:

➤ The ability to select a Controller host for a test.

➤ The test summary view has been enhanced.

➤ Assigns host properties (for example, installed on a Citrix client) for 
allocating appropriate hosts during a run.

➤ Assigns both automatch (virtual) and specific (actual) hosts in the same 
test.

➤ Tags a group to facilitate test design and modifications.

➤ Assigns multiple scripts to a test simultaneously.

➤ Runtime settings: The ability to manage Additional Attributes in 
ALM Performance Center.

➤ J2EE/.NET Diagnostics integration (HP Diagnostics 9.0 only): The ability 
to filter probes using the health status field.
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➤ Service Level Agreements (SLAs):

➤ There is a new SLA type called Transaction Percentile.

➤ The ability to set decimal values as thresholds.

➤ The number of transactions that can be measured in the SLA is no 
longer limited.

➤ There is a new report that displays the SLA status.

Start Run
The following enhancements have been made to the Start Run process:

➤ The process now covers more test initialization steps, such as host 
allocation. 

➤ Performance tests now start faster than before.

➤ Performance tests can be cancelled in the initialization phase if a critical 
error occurs.

My Performance Center
My Performance Center is an additional view which provides an interface 
specifically designed for test execution. It allows you to create a personalized 
view of performance testing features, facilitating execution of day-to-day 
performance testing activities.
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Standalone Applications

The following standalone application enhancements have been added:

VuGen and Protocols
New protocols and features have been added, and enhancements have been 
made to existing features:

➤ Ajax TruClient. A new advanced protocol for modern JavaScript-based 
applications, including Ajax. The protocol emulates user activity within a 
Web browser. Scripts are developed interactively in Mozilla Firefox. 

➤ Silverlight. A new protocol for Silverlight-based applications emulating 
user activity at the transport level. This protocol allows the generation of 
high-level scripts by automatically importing and configuring WSDL files 
used by the application.

➤ Java over HTTP. A new protocol designed to record Java-based 
applications and applets. This protocol produces a Java language script 
using Web functions, and is distinguished from other Java protocols in 
that it can record and replay Java remote calls over HTTP.

➤ Data Format Extension (DFE). A new feature that enhances data format 
capabilities for the Web (HTTP/HTML) protocol family. This feature 
allows the conversion of raw HTTP traffic into a maintainable and 
structured XML format, and enables correlations by XPATH.

➤ Correlation Studio. This Web (HTTP/HTML) automatic correlation 
mechanism has been enhanced to search for possible correlations in the 
larger scope of snapshot data created during code generation, including 
data formatted by DFE.

➤ Snapshot View. New snapshot view for the Web (HTTP/HTML) protocol 
steps enables viewing complete HTTP traffic in both raw and DFE 
generated formats.

For more information, refer to the HP Virtual User Generator User Guide.
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Analysis
The following enhancements were made to HP Analysis.

For more information, refer to the HP LoadRunner Analysis User Guide.

Area Enhancement

Reporting capabilities ➤ Fully customizable report templates that allow 
you to control the content and format of a 
report. 

➤ Exports the report to different formats, such as 
Word, Excel, PDF, or HTML for any reporting 
purpose.

➤ Using the Analysis Session template, you can 
associate multiple report templates, each in a 
different time range.

➤ Automatically generates reports upon creation 
of Analysis data via standalone Analysis.

Service Level Agreement 
(SLA)

➤ Added the Transaction percentile SLA type.

➤ Sets decimal threshold values.

Usability ➤ Filters the graph legend, graph data, or raw 
data by any column by using wildcards and 
'like' statements.

➤ Filters a graph before opening it.

Note: This may reduce the Analysis process 
footprint when working with large sessions.

➤ Whole Measurement names in the graph 
legend in the HTML report are now visible.

➤ Enhanced user interface for managing Analysis 
session templates.
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Feature Mapping

This section includes mapping information that enables you to locate HP 
Performance Center 9.5x features in HP ALM Performance Center 11.00.

This section includes:

➤ "Performance Center 9.5x Administration Site Feature Mapping" below

➤ "Performance Center 9.5x User Site Feature Mapping" on page 46

Performance Center 9.5x Administration Site Feature 
Mapping
The following table shows the location of Performance Center 9.5x 
Administration site features in ALM Performance Center 11.00 Lab 
Management. For information on how to log in to Lab Management, refer 
to the HP ALM Performance Center Guide.

Feature
Performance 
Center 9.5x 
Module

ALM Performance Center 11.00 Lab 
Management 

Hosts Resources On the Lab Management sidebar, 
under Lab Resources, select Hosts.

MI Listeners Resources On the Lab Management sidebar, 
under Lab Resources, select 
MI Listeners.

Host Locations Resources On the Lab Management sidebar, 
under Lab Resources, select 
Locations.

Host Pools Resources On the Lab Management sidebar, 
under Lab Resources, select Host 
Pools.

Servers Resources On the Lab Management sidebar, 
under Lab Resources, select 
PC Servers.
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Test Runs Site Management On the Lab Management sidebar, 
under Lab Resources, select Test 
Runs.

Timeslots Site Management On the Lab Management sidebar, 
under Lab Resources, select 
Timeslots.

Autostart Viewer Site Management ➤ Past autostart performance tests. 
On the Lab Management sidebar, 
under Lab Usage, select Test Runs.

➤ Future autostart performance 
tests. On the Lab Management 
sidebar, under Lab Usage, select 
Timeslots. The future tests can be 
identified by their start date.

Event log Site Management ➤ On the Lab Management sidebar, 
under Lab Resources, select Hosts.

➤ On the Lab Management sidebar, 
under Lab Usage, select Test Runs.

➤ On the Lab Management sidebar, 
under Lab Settings, select PC 
Servers.

➤ In Lab Management common 
toolbar, select Tools > Event Log.

License System 
Configuration

On the Lab Management sidebar, 
under Lab Settings, select License.

General Settings System 
Configuration

In the Lab Management common 
toolbar, select Tools > Performance 
Center General Settings.

Diagnostics System 
Configuration

On the Lab Management sidebar, 
under Lab Settings, select 
Diagnostics.

Server 
Configuration

System 
Configuration

On the Lab Management sidebar, 
under Lab Settings, select PC Servers.

Feature
Performance 
Center 9.5x 
Module

ALM Performance Center 11.00 Lab 
Management 
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Server 
Authentication

System 
Configuration

Server authentication is now 
performed using ALM User 
Management functionality.

Alerts 
Configuration

System 
Configuration

Monitoring is now performed by an 
internal periodic check host 
mechanism that replaces SiteScope.

Reports Reports On the Lab Management sidebar, 
under Lab Usage, select 
Usage Reports

Notes:

➤ Two new reports are available:

➤ VUDs License Project Usage 
Report

➤ VUDs License Site Usage Report

➤ The Site Users Report is no longer 
available.

Personal Details User Management In the ALM Project, select Tools > 
Customize > User Properties. 

Users User Management In the ALM Project, select Tools > 
Customize > Project Users.

Roles & Privilege 
Management

User Management In the ALM Project, select Tools > 
Customize > Groups and Permissions.

Projects User Management ➤ Add project: You create projects in 
Site Administration. For 
information about accessing Site 
Administration, refer to the 
HP Application Lifecycle 
Management Administrator Guide.

➤ Project information: To define 
project settings, on the Lab 
Management sidebar, under 
Lab Settings, select 
Project Settings.

Feature
Performance 
Center 9.5x 
Module

ALM Performance Center 11.00 Lab 
Management 
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Performance Center 9.5x User Site Feature Mapping
The following table shows the location of Performance Center 9.5x User site 
features in ALM Performance Center 11.00. For information on how to start 
ALM, refer to the HP Application Lifecycle Management User Guide.

Feature
Performance Center 
9.5x Module

ALM Performance Center 11.00

Status > General Project Only available in Performance 
Perspectives. For more 
information on Performance 
Perspectives, refer to the 
HP ALM Performance Center Guide: 
My Performance Center.

Status > Dashboard Project On the ALM sidebar, under 
Requirements, select 
Requirements. Then select View > 
Coverage Analysis.

Note: This is not an exact 
reproduction of the Performance 
Center Dashboard. In ALM 
Performance Center 11.00:

➤ Transaction level status can 
only be viewed in the SLA 
report.

➤ You must define the 
requirements in order to get 
full status information.

Hosts Project On the ALM sidebar, under Lab 
Resources, select Hosts.

Timeslots Project On the ALM sidebar, under Lab 
Resources, select Timeslots.

Topologies On the ALM sidebar, under Lab 
Resources, select Topologies.

Note: Topologies is a new feature.
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Vuser Scripts Project On the ALM sidebar, under 
Testing, select Test Plan

Note: A table detailing basic 
information for all the scripts in 
the project is not available. To 
view information for an 
individual script, select Script 
Folder > <desired script>. The 
information displays in the upper 
right hand pane

Monitor Profiles Project On the ALM sidebar, under 
Testing, select Test Resources.

Autostart Viewer Project ➤ Past autostart performance 
tests. On the ALM sidebar, 
under Testing, select Test Lab

➤ Future autostart performance 
tests. On the ALM sidebar, 
under Lab Resources, select 
Timeslots. The tests can be 
identified by their start date.

Options Project On the ALM sidebar, under Tools, 
select PC Project Settings. 

Change Project Project On the ALM sidebar, under Tools, 
select Change Project

Manage Load Tests On the ALM sidebar, under 
Testing, select Test Plan

Test Runs Load Tests On the ALM sidebar, under 
Testing, select Test Lab. Then 
select the Test Runs tab.

Trend Reports Load Tests On the ALM sidebar, under 
Testing, select Test Lab. Then 
select the Test Runs tab and click 
the Performance Trending 
button . 

Feature
Performance Center 
9.5x Module

ALM Performance Center 11.00
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Personal Details User Management In the common toolbar, select 
Tools > Customize > User 
Properties.

Users User Management In the common toolbar, select 
Tools > Customize > Project Users

Roles User Management In the common toolbar, select 
Tools > Customize > Groups and 
Permissions.

Projects Not available in ALM 
Performance Center 11.00.

Privilege 
Management

User Management In the common toolbar, select 
Tools > Customize > Project Users.

Downloads Miscellaneous In the common toolbar, select 
Tools > Download Standalone 
Applications.

What’s New Miscellaneous In the common toolbar, select 
Help > What’s New

Feature
Performance Center 
9.5x Module

ALM Performance Center 11.00
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